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1 Introduction 

This document contains a step-by-step guide for setting up and running DHI’s MIKE 21/3 

Coupled Model FM Shoreline Morphology for the Headland Beach Example. All files 

needed to run the guide are located in the folder HeadlandBeach. Before starting working 

on the example, copy the entire folder to your local user directory.  

 

The example is concerned with investigating different mitigation options for a section of a 

headland beach shown in Figure 1.1.  

 

 
 
Figure 1.1 The headland beach studied in the present example  

 

As this is not a real case, a synthetic bathymetry has been created and is provided in the 

mesh file which is part of the example. The bathymetry is shown in Figure 1.2 which also 

shows the mesh resolution. The section of shoreline which we will be looking at in this 

example is covered by the finest mesh resolution in the nearshore area.  

 

The longshore sediment transport along this shoreline is assumed to be driven by waves 

only, i.e. tidal currents and surface elevations are ignored.  
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Figure 1.2 The synthetic bathymetry (left) together with the mesh resolution in area of interest (right)  

 

 

The following files are part of this example: 

 

• HeadlandBeach.mesh 

• stokes_5_d50_0.18_sigma_1.3_no_ripples.lon 

• stokes_5_d50_0.18_sigma_1.3_no_ripples.crs 

• HeadlandBeach_standard_morphology.mfm 

• HeadlandBeach_shoreline_morphology.mfm 

• HeadlandBeach_shoreline_morphology_baseline.mfm 

• HeadlandBeach_shoreline_morphology_breakwater.mfm 

• HeadlandBeach_shoreline_morphology_groyne.mfm 

• HeadlandBeach_shoreline_morphology_headland.mfm 

• make_shoreline_inputs.mdf 

• baseline.xyz 

• coastline.xyz 

• edgemap.dfsu 

• profile_cld_8_dune_1.xyz 

• coastline_warmed_up.dfs1 

• breakwater_points.xyz 
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2 Setup and Run the MIKE 21 Sand Transport FM Model 

This guide assumes that you are familiar with setting up a standard coupled MIKE 21 

Sand Transport FM Model. If you are not familiar with this, please refer to the step by step 

guide, which can be accessed via the MIKE Zero Documentation Index in the start menu: 

 

MIKE 21/3 Coupled Model FM, Step-by-Step Training Guide: Coastal Application 

 

Our starting point in this guide is therefore that a standard coupled MIKE 21 Sand 

Transport FM Model has been setup, so open and check that you can run the file 

HeadlandBeach_standard_morphology.mfm. 

 

 
 
Figure 2.1 Impact of breakwater default morphology  

 

Have a look at how the model has been setup; especially note that the HD model is run in 

quasi-stationary mode as shown in Figure 2.2; other important setup parameters are 

listed in Table 2.1.   
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Running this model will take some time and we will not use the results for anything as we 

are focused on the Shoreline Morphology model, so either stop the model simulation, or 

while it is running, move on to the Shoreline Morphology model in the next section.  

 

 
 
Figure 2.2 Quasi steady HD solver is used   

 
  



Setup and Run the MIKE 21 Sand Transport FM Model  

 5 

Table 2.1 Parameters used in the standard setup of the couple HD, SW and ST model 
(continued on next page) 

 

Hydrodynamic Module  

Basic Equations Quasi stationary formulation 

Solution technique Shallow water equations 

Time integration/Space discretisation: Low order fast algorithm 

Quasi-stationary solver 

Maximum time step interval: 10800 s 

Tolerance (RMS-norm dh/dt): 5e-006 

Tolerance (RMS-norm duv/dt): 5e-005 

Flood and dry Default values 

Eddy viscosity  Smagorinsky with default value  

Bed resistance Manning = 32 m^(1/3)/s 

Coriolis Forcing, Wind, Ice, 

Tidal Potential, Precipitation, 

Infiltration 

Excluded 

Wave Radiation Type: Wave radiation from SW simulation 

Boundary conditions East: Land boundary (zero Normal velocity) 

South: Land boundary (zero Normal velocity) 

North: Land boundary (zero Normal velocity) 

Sand Transport Module  

Model Definition Sediment transport table: 

stokes_5_d50_0.18_sigma_1.3_no_ripples.lon 

Sediment properties Median grain size 0.18 mm 

Grading coefficient: 1.3 

Forcings - Waves Type: Wave field from SW simulation 

Morphology - General Max bed level change: 10m/day 

Speedup factor 1 

Include feedback on HD, SW and ST: True 

Spectral Wave Module  

Basic Equations Spectral formulation: 

Directionally decoupled parametric formulation 

Time formulation: 

Quasi stationary formulation 

Spectral Discretisation Directional Discretisation: 

Number of directions: 16 
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Spectral Wave Module cont’d:  

Solution technique Shallow water equations 

Time integration/Space discretisation: Low order fast algorithm 

Quasi-stationary solver 

Maximum number of iterations: 50 

Tolerance (RMS-norm of residual): 1e-5 

Tolerance (max-norm of ΔHs): 1e-2 

Water Level Conditions Type: Water level variation from HD simulation 

Current Conditions From HD simulation 

Wind, ice, diffraction Excluded 

Wave Breaking Specified gamma default values 

Bottom Friction Nikuradse roughness kn = 0.01 m, include effect on mean 

frequency 

Boundary conditions South: Lateral boundary  

East: Hs = 2.5 m, Tp = 12 s, MWD = 140, DSI = 10 

North: Lateral boundary 
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3 Initial Look at the Shoreline Morphology Model 

Open the file HeadlandBeach_shoreline_morphology.mfm. The Shoreline Morphology 

model is activated by selecting it on the module selection panel as shown in Figure 3.1. It 

is only possible to select the Shoreline Morphology if both the HD, SW and ST modules 

are selected. 

 

  
 
Figure 3.1 Module selection 

 

The Shoreline Morphology model lives inside the Morphology section of the Sand 

Transport Module. When selecting Shoreline model an overview of the mesh and the 

Shoreline Morphology model inputs are shown graphically on the input pane as shown in 

Figure 3.2; it is possible to zoom in the figure or change the background to either show 

the mesh, the bathymetry or the edge map (default).  
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Figure 3.2 Overview of the Shoreline model 

 

As seen in Figure 3.2, there are 6 subsections to the Shoreline model where we need to 

select inputs for the Shoreline Morphology model, but first we need to generate the inputs 

for the model, namely the Baseline, the Coastline, the Edge map and the Profile. These 

inputs can all be generated using a new tool in the Mesh Generator based on a mesh file. 

This is what we will do in the next section. If you just want to get started running the 

model using the supplied inputs, you can go straight to section 5.  
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4 Creating input files for the Shoreline Morphology Model 

All input files for the Shoreline model will be generated using the Mike Zero Mesh 

Generator. A new tool is available in the “Shoreline” menu shown in Figure 4.1. 

 

 
 
Figure 4.1 Shoreline menu in Mesh Generator 

 

4.1 Step 1: Load Mesh 

First we load the mesh (use the projection: MGA-56) which we would like to use in our 

simulation and enable arc editing as shown in Figure 4.2. Load in the mesh 

HeadlandBeach.mesh. 

 

 
 
Figure 4.2 Load mesh and enable Arc Editing 
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4.2 Step 2: Create Baseline 

Looking at the mesh you can see that there is fine resolution in the nearshore area along 

our area of interest. Zoom into that area and use the arc tool to draw the baseline along 

the shoreline in our area of interest as shown in Figure 4.3. Make sure that you start on 

the left end of the shoreline when looking towards the sea, as shown with the red arrow in 

Figure 4.3.  

 

 
 
Figure 4.3 Drawing the baseline using the arc tool along the area of interest 

 

Next, redistribute the number of vertices on the baseline to match the desired resolution 

of the shoreline points. This resolution must match with the mesh resolution in the 

nearshore area such that we have at least 3-4 mesh elements between adjacent baseline 

vertices. In Figure 4.5, 200 m between vertices was chosen together with a spline tension 

factor of 0.5 as shown in Figure 4.4.  
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Figure 4.4 Redistribute vertices on baseline arc 

 

 
 
Figure 4.5 Baseline with redistributed vertices  
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Now the attributes of the baseline are set to 100 with the start node attribute set to 99 as 

shown in Figure 4.6.  

 

 
 
Figure 4.6 Setting the attributes of the baseline 

 

4.3 Step 2: Create Initial Coastline 

Now we are ready to create the initial coastline position. Again, we draw this as an arc 

using the arc tool. First turn on the depth contours of the mesh (Mesh->Contour type-

>Shaded contours); choose a colour palette that enables you to clearly see the 0 meter 

depth contour as shown in Figure 4.7 (use Mesh -> Contour Palette -> New). Start 

drawing the coastline arc from the left end of the shoreline when looking towards the sea 

(shown with the red arrow) and make sure your first point and last nodes are outside the 

first and last nodes of the baseline arc.  

 

 
 
Figure 4.7 Creating initial coastline with first and last point outside the range of the baseline 
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The number of vertices on the coastline is not important as we will use a tool to make it 

match correctly to the number of points on the baseline. First set the attributes of the 

coastline to 110 (with the start node attribute set to 109) as shown in Figure 4.8. 

 

 
 
Figure 4.8 Setting the attribute of the coastline arc  

 

Now select Manage Shoreline Data from the Shoreline menu as shown in Figure 4.9. Set 

the attribute of the baseline and coastline to the values chosen for the respective arcs and 

press Modify coastline arc. 

 

 
 
Figure 4.9 Manage shoreline data 

 

Your coastline arc should now have the correct number of points, i.e. one more point than 

the baseline. Note that the first and the last point on the coastline are only used for 

boundary condition purposes in the Shoreline Morphology model. The boundary condition 

is zero gradient in the transport over the boundary which means that the orientation of the 

first and last shoreline segment does not change during the simulation; thus setting it to 

something reasonable to begin with is recommended. Here, in our simple example it is 

easy.  
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Figure 4.10 Modified coastline arc 

 

Now we are ready to save our baseline and coastline. Select Export shoreline data from 

the Shoreline menu and select the location of the baseline and coastline before pressing 

Ok, see Figure 4.11.  

 

 
 
Figure 4.11 Export shoreline data 
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It is a good idea to add the node number as the fourth column in the baseline.xyz file. This 

can be done using excel combined with an advanced text editor as shown in Figure 4.12. 

By doing this we can load in the node number on top of 2D results files in the Data Viewer 

this makes it easier to see where in the 2D results our baseline/coastline results are 

located.  

 

 
 

Figure 4.12 Add the baseline node number as the fourth column in the baseline.xyz file 

 

4.4 Create Edge Map 

Now we would like to create our edge map. To do so we first need to create an arc 

defining the offshore boundary of the map. The values in the edge map will be calculated 

between the baseline and this offshore arc; outside this defined area the map values are 

zero and the shoreline morphology will not be active. The off-shore arc should be located 

further offshore than the depth of closure, but close enough to shore so that the normals 

to the baseline segments do not cross each other; for highly curving shorelines there is a 

trade-off where the depth of closure in the model is limited by the curvature. Furthermore, 

the mesh resolution must be relatively fine in the area, but it can be coarser than in the 

nearshore area as we do not expect wave breaking in this area. In the present case we 

will locate it beyond the 8 m contour as shown in Figure 4.13 just inside the fine (but not 

finest) mesh resolution. Then the attribute of this arc is set to 120, see Figure 4.15.  
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Figure 4.13 Offshore arc has been added beyond the 8 m contour but inside the fine resolution  

 

 

 
Figure 4.14 Zoom of Figure 4.13  
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Figure 4.15 Setting attributes of off-shore arc 

 

Now we can select Manage edge map from the Shoreline menu, set the attribute to the 

one we chose before and press Create Edge Map, see Figure 4.16.  

 

 
 
Figure 4.16 Manage Edge Map 

 

Your edge map should now be visible as shown in Figure 4.17. If you changed your 

palette to fixed when drawing the shoreline arc you probably need to change it to linear 

auto-scaled ((use Mesh -> Contour Palette -> New)). We can now export the map by 

selecting Export Edge Map from the Shoreline menu. 
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Figure 4.17 Edge Map.  

 

 
 
Figure 4.18 Export Edge Map 

 

Once it has been exported, open it in the Data Viewer and check that it matches your 

expectations, first of all; that the strips do not cross and that the resolution of the mesh 

matches the resolution of the shoreline, i.e. each strip should be 3-4 mesh elements wide 

as shown in Figure 4.19.  
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Figure 4.19 Edge map open in Data Viewer 

 

4.5 Create Profiles 

The last thing we need to create is the coastal profile; the coastal profile can either be 

loaded from xyz files or extracted from the bathymetry in the mesh. In the present case 

we will extract it from the mesh by reading in the mesh as a scatter data file as shown in 

Figure 4.20. Then please proceed to interpolate the scatter data onto the mesh.  
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Figure 4.20 Load the xyz-data from an existing mesh file through the “Manage scatter data“ 

menu.  

 

Then select Manage profiles from the Shoreline menu and set the Profile start, Profile end 

and Number of points as shown in Figure 4.21.  
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Figure 4.21 Manage profiles. Note that the profile start is on land and the profile end is off-shore 

 

In the current example the coastal profile is constant along the shoreline so we just need 

to extract a single profile. Do so by clicking Add, then select which profile to extract from 

the pull down menu shown in Figure 4.22. Pick a profile on the middle of the shoreline 

section, so select Coast ID 25 or similar then click Apply, OK and OK. You can now see 

the profile(s) you have selected and its extent as shown in Figure 4.23.  

 

 
 
Figure 4.22 Select profile for extraction from mesh 
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Figure 4.23 Location of selected profiles 

 

If you are happy with the profile location and extent, the profile can now be exported to an 

xyz file using Shoreline->Export Profiles. Select Single profile and specify the file name to 

save the profile to (cf. Figure 4.24). Since we have only extracted one profile from the 

mesh the coast ID does not matter (all profiles along the baseline will be the same). But in 

case we had extracted more than one profile we could export the varying profiles as a 

dfs2 file instead.  

 

 
 
Figure 4.24 Export profiles 

 

As we are now done creating our shoreline inputs, save the mdf file to a new name, e.g. 

make_shoreline_model_inputs.mdf.  

 

The last thing we need to do is to fix the profile onshore of the dune height and seaward 

of the closure depth so the gradient of the profile is steeper than the gradient in the mesh 

as shown in Figure 4.25. This can be done for the xyz file in any text editor; if the profiles 
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were varying, the dfs2 file would need to be fixed in the same way, this can be done using 

by opening and editing the file in MIKE ZERO.  

 

 
 
Figure 4.25 Comparison of raw (extracted from the mesh) and fixed profile  

 

The procedure is to delete the set of values in the extracted profile which are below the 

closure depth and then add a single set of values to define the steep gradient as shown in 

Figure 4.26. The same thing should be done for the dune height.  

 

  
 
Figure 4.26 Delete the values below the closure depth (here = 8 m) marked with blue on the left 

panel. Then insert a single value pair defining a steep gradient of 1/100 shown in the 
right panel  

 

Now we are ready to setup and run the Shoreline Morphology model in the next section. 
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5 Baseline Case 

In this section we will setup and run the Shoreline Morphology model for the baseline 

case, i.e. without any mitigation measures.  

 

5.1 Setup the Shoreline Morphology Model 

Our starting point is the coupled HD, SW and ST setup named 

HeadlandBeach_standard_morphology.mfm, so open this file and save it under a different 

name, e.g. HeadlandBeach_shoreline_morphology.mfm. Then activate the Shoreline 

morphology in the Module Selection section as shown in Figure 5.1. As seen, the model is 

telling us on the bottom panel that the baseline, coastline, edge map and profile inputs are 

missing from the Shoreline Morphology model.  

 

In each section simply point to the files created in the previous section or to the files 

supplied in the example folder as shown in Figure 5.2, Figure 5.3, Figure 5.4 and Figure 

5.5. In the profile section also set the closure depth (= 8 m) and the dune height (= 1 m).  

 

 
 
Figure 5.1 Activate Shoreline morphology 
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Figure 5.2 Select Baseline file 
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Figure 5.3: Select Coastline file 
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Figure 5.4 Select Edge map file 
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Figure 5.5 Select Profile file and set Closure depth and Dune height 

 

Check the solution technique section (in the shoreline model section), normally the default 

values are OK, but if your model is not converging within the specified 100 iterations, 

increase the tolerance in this section. It is important that the model converges for most 

time steps, if the maximum number of iterations is reached, the iterated solution is not 

used, rather the solution found directly from the modified one-line equation is used; this 

may contain small mass errors which add up over the long term. 

 

In MIKE 2017 a new feature was introduced to remove exchange of sediment over the 

offshore boundary/closure depth. The feature ensures by default that any loss/supply of 

sand over the offshore boundary/depth of closure does not impact the volume calculations 

that affect the shoreline evolution. 

 

Note that the simulated offshore/onshore volumes along the offshore boundary/depth of 

closure is written to the coastline.dfs1 output file regardless of whether the effect of 

offshore transport is included or excluded in the volume balance.  
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Figure 5.6 Solution Technique 

 

Once we have specified all the inputs we can check that they look OK by clicking on the 

Shoreline Morphology section as shown in Figure 5.7.  
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Figure 5.7 Check inputs in the Shoreline morphology section  

 

Finally, we need to specify a new output, which contains the results from the Shoreline 

Morphology model. So in the outputs section of the Sand Transport Module add a new 

output and select Coastline for field type as shown in Figure 5.8. Select the variables that 

you want to place on the Output items tab as shown in Figure 5.9.  
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Figure 5.8 Specify the Coastline output and give the new output a name 

 

 

 
 
Figure 5.9 Select items for the Coastline output 
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5.2 Run the Shoreline Model 

Now we are ready to run the model, select ‘Run -> Start simulation’ and make sure you 

set the number of threads per subdomain and Number of sub-domains to sensible values, 

i.e. one times the other should not be more than the number of available cores.  

 

 
 
Figure 5.10 Launch settings 

 

Click OK and the model should start running. After a few time steps all three modules 

should be converging very fast at each time step. This is because of the constant 

boundary conditions in both the HD and SW modules. Note that the estimated time for the 

model to finish will be large in the beginning when the HD and SW modules are finding 

the quasi steady solution, but should reduce significantly. On a 4 core laptop the model is 

running in around 15 minutes.  

 

You can check that the modules are converging by looking the output of convergence files 

that you can specify for the SW and HD module. Convergence information for the SM 

model is written in the bottom panel as shown in Figure 5.11. Note that the MD: lines are 

from the Shoreline Morphology model, it is not written whether the model converged or 

not, but when the number of iterations is smaller than the maximum number of iterations 

(default = 100) specified in the solution technique section, then the model has converged.  

 



 MIKE 21/3 Coupled Model FM 

34 Shoreline Morphology Module - © DHI 

 
 
Figure 5.11 Check that the SM module is converging in the simulation window 

 

5.3 Initial Results 

The first result we will look at is the littoral drift along the shoreline. Even if the model is 

still running we can look at this result and start thinking about it. Click on the View button 

next to the coastline result in the Outputs section of the Sand Transport Module as shown 

in Figure 5.12.  
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Figure 5.12 Click on the View button to view results from the Shoreline Morphology model 

 

 

The dfs1 file should open, and we can select the littoral drift item as shown Figure 5.13. 

 

 
 
Figure 5.13 Select the Littoral drift item 
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Move down some time steps until the littoral drift has stabilized (in time) as shown in 

Figure 5.14. The first point is the leftmost when standing on the beach and looking 

seaward; thus the first point is northernmost and the last point is the southernmost. The 

littoral drift is positive going to the right. So for these wave conditions we have increasing 

northward transport when moving from the southern end of the baseline towards the 

centre of the baseline and then slightly decreasing littoral drift along the rest of the 

baseline towards the north. Thus we expect to see erosion on the southern end of the 

area of interest and more stable development on central and north sections. As the 

shoreline position reacts to the gradients in the littoral drift, many of the spikes in the drift 

go away as shown in Figure 5.14.  

 

 

 
 
Figure 5.14 The littoral drift along the baseline. Top: in the beginning of the simulation. Bottom: At the end of the 

simulation 
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Switching to the accumulated change of shoreline position we can see the erosion and 

accretion pattern along the baseline as shown in Figure 5.15. It is noted that the signal is 

noisy; the noise is due to the limited mesh resolution and the highly non-linear nature of 

sediment transport in the surf zone. We can get rid of some of the noise by refining the 

mesh or running the model again and using our results from the first run as input to the 

second run, (i.e. the run we just completed is a warm-up run).  

 

 
 
Figure 5.15 Accumulated change in shoreline position at the end of the simulation 

 

5.4 Setup using Warm-up Result 

Save the setup file to a new name, e.g.: 

 

HeadlandBeach_shoreline_morphology_baseline.mfm  

 

and change the start year of the simulation to 2005. Then change the coastline file type to 

dfs1 file and point to the result file from the simulation which just finished as shown in 

Figure 5.16. Then run the model again. This new model will be our baseline Shoreline 

Morphology model. 
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Figure 5.16 Change the type of the coastline input to dfs1 and point to the result file from the 

previous simulation 

5.5 Results 

While the new model is running we can have a look at some of the other results.  

 

Next switch to the item named Net offshore transport. This item shows the accumulated 

transport across the closure depth for each shoreface strip, i.e. into/out of the Shoreline 

Morphology model domain. To get a perspective on the size of this transport it is a good 

idea to look at the item Vertical area in front of shoreline edge. The accumulated change 

in shoreline position due to the net offshore transport is the Net offshore transport divided 

by the Vertical area in front of shoreline edge. Look in the General Description of the 

shoreline model in the help section (press F1 to bring up the help) or in the User Guide, 

which can be accessed via the MIKE Zero Documentation Index in the start menu:  

 

MIKE 21 Flow Model FM, Sand Transport Module, User Guide 
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In some cases the off-shore transport can be a significant contribution and it must be 

considered if this contribution is wanted or not; in many cases we do not want to include 

the impact of the off-shore transport on the change in shoreline position in which case it 

can be removed in a post-processing step. In the present case it is found that the net off 

shore transports accounts for less than 0.5 m of shoreline movement at the location with 

the largest net off-shore transport.  

 

 
 
Figure 5.17 Net off-shore transport 

 

 

 
 
Figure 5.18 Vertical area in front of each shoreline edge 
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Once your baseline model simulation is done you can have a look at the accumulated 

change in shoreline position to see if the warm up run made a difference. Figure 5.19 

shows the accumulated change in shoreline position after 1 year for the warm-up run and 

the baseline run. It is seen that the spikes are smaller for the baseline run, so the warm-

up does have an effect although there are still some large spikes in the baseline run; 

these can be removed by running the warmup run for a longer period.  

 

As it is almost impossible to set the initial shoreline position to be in equilibrium with the 

forcing from the waves, it is normally recommended to perform a warm-up run to remove 

the initial reorientation of the shoreline from the actual results.  

 

 

 
 
Figure 5.19: Comparison of the accumulated change in shoreline position after 1 year for the warm-up run and the 

baseline run. Note that the x axis shows baseline point number * 100, so 3000 = point 30 

 

 

The initial bed level change is shown in Figure 5.20 is the difference between the bed 

level in the mesh file and the bed level determined by the specified coastal profile and 

initial shoreline position in the Shoreline Morphology model. While this is nice to know, it 

disturbs the change in bed level for all other time steps, so it is a good idea to remove this 

initial bed level change from the bed level change of the remaining time steps. This can 

be done using the Data Manager as explained in the following.  
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Figure 5.20 Initial bed level change  

 

First, extract the bed level change at the first time step using Data Extraction FM as 

shown in Figure 5.21, it is important to only extract the first (i.e. 0 ) time step.  
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Figure 5.21 Extract the bed level change for the initial time step  

 

 

Open the .dfsu file in DataUtility and increase the time step to cover the length of the 

simulation period. Then open the ST.dfsu file in the Data Manager, then select the bed 

level change item and Edit -> Calculator 

 

 
 
Figure 5.22 Select Edit and Calculator in the Data Manager 

 

Now add a new variable (Figure 5.23) and select the file with the initial bed level change, 

which we just extracted (Figure 5.24). 



Baseline Case  

 43 

 
 
Figure 5.23 Add new variable  

 

 
 
Figure 5.24 Select the initial bed level change 
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Now type the expression for the current item as shown in Figure 5.25 and press 

Calculate.  

 

 
 
Figure 5.25 Type expression for Current item 

 

Save the file, close Data Manager and open the file in Data Viewer. 

 

The bed level change in the first and last time step should now look as shown in Figure 

5.26. Note that the baseline.xyz file has been loaded using Right Click -> Add/Remove 

layers -> xyz file -> Edit -> XYZ Frame and Value (see Figure 5.27). So we can see that 

the area with the worst erosion is between baseline nodes 29 and 37 in agreement with 

Figure 5.19.  
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Figure 5.26 Initial (left) and final (right) bed level change after removing the initial bed level changes 

 

 

 
 
Figure 5.27 Add/Remove layers in Data Viewer 
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6 Breakwater Scenario 

In this section we will add an off-shore breakwater to protect the area undergoing erosion 

in the baseline case. 

 

The offshore breakwater will be added to the model by adding a dyke structure in the HD 

model and a line structure with the same geometry in the SW model.  

 

The breakwater should be positioned such that the salient expected to form in the lee of 

the breakwater is located in the area experiencing the worst erosion in the baseline case.  

 

6.1 Setup and Run the Shoreline Morphology Model 

The starting point is the baseline setup: 

HeadlandBeach_shoreline_morphology_baseline.mfm. Save the file under a new name: 

HeadlandBeach_shoreline_morphology_breakwater.mfm; then add a dike in the 

Hydrodynamic module by right clicking in the dikes section as shown in Figure 6.1.  

 

 
 
Figure 6.1 Add a new dyke in the hydrodynamic module 

 

Next, set the overtopping to zero and copy the geometry of the dike as shown in Figure 

6.3 and Figure 6.3, respectively.  
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Figure 6.2 Set the overtopping discharge to zero 

 

  
 
Figure 6.3 Define the geometry of the dike  
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Copy and paste the copied coordinates from Figure 6.3 into a text file in your favourite 

text editor, so it can be used for creating a line structure in the SW module. Then add a 

zero on both lines and save the file as breakwater_points.xyz, see Figure 6.4.  

 

 
 
Figure 6.4 Create a xyz file with the coordinates of the breakwater  

 

Next, add a new line structure in the SW module and add two points on the geometry 

page of the new line structure, make sure the coordinate system is correct. Then paste 

the geometry copied from the dyke to the line structure as shown in Figure 6.5, or load the 

geometry from the breakwater_points.xyz file.  

 

 
 
Figure 6.5 Paste the geometry of the dyke to the new line structure in the SW module 

 

Now set the reflection and the transmission coefficients of the line structure to zero as 

shown in Figure 6.6.  

 

We have now inserted an offshore breakwater in our Shoreline Morphology model, so we 

will run the model and look at the results.  
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Figure 6.6 Set the transmission and reflection coefficients to zero for the line structure 

 

6.2 Results 

First, let us look at the effect of the line structure on the wave field. Open the SW output 

and add the breakwater_points.xyz and the baseline.xyz files by right clicking and using 

Add/Remove Layers so we can see where the breakwater and baseline nodes are 

located; then do the same for the HD and ST results. Remove the initial bed level 

changes from the bed level change item in the ST file as explained in Section 5.5.  

 

Figure 6.7 shows the effect of the breakwater on the wave height, current speed, 

sediment transport and bed level changes. It is noted that the wave height is greatly 

reduced in the lee of the breakwater, in this zone the current speed is also reduced as is 

the sediment transport. This cause a salient to form in the lee of the breakwater 

accompanied by down-drift erosion as seen the bottom right panel.  
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Figure 6.7: Effect of the breakwater on the wave height field (top left), current field (top right), sediment transport field 

(bottom left) and change in bed level (bottom right). Note that the initial bed level change has been 
removed as explained in Section 5.3 

 

 

Figure 6.8 compares the accumulated change in shoreline position for the baseline case 

and the breakwater case. It is seen that a large salient (~50 m wide) forms in the lee of 

the breakwater, accompanied by down-drift erosion of around 35 m. Compared with the 

existing conditions the impact of the breakwater is much larger; it would probably be a 

good idea to make the breakwater smaller to reduce the impact.  
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Figure 6.8: Comparison of the accumulated change in shoreline position along the shoreline  
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7 Further Exercises 

It is quite easy to test other mitigation schemes such as groynes or artificial headlands in 

the Shoreline Morphology model. Simply add the structure in both the HD and the SW 

module and run the model; examples are shown in Figure 7.1 and Figure 7.2, 

respectively. These setup files are located in the example folder. 

 

 
 
Figure 7.1 Example of an artificial headland 

 

In MIKE 2017 it is now possible to illustrate simulated shoreline positions in MIKE Result 

Viewer. This is done by reading in the coastline.dfs1 file and selecting to show the 

coastline in xy-space. It is thereby possible to compare different simulations as is done in 

Figure 7.3. 
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Figure 7.2 Example of an artificial groyne added to the model 

 

 

 
 
Figure 7.3 Comparison of simulated shorelines for three different cases in MIKE 21 SM FM. The 

colours show the simulated 2D response for the case without structures (standard 
morphology) 
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